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1.Introduction

The aim of this example is to show an project of the endpoint LoRaWAN stack implementation.

This LoRaWAN stack is an EU868 and US915 bands Class A and Class C endpoint implementation
fully compatible with LoRaWAN 1.0.2 specification.

Each LoRaWAN application example includes the LoRaWAN certification protocol implementation.

SX1276 radio drivers are also provided.

In case only point to point links are required a Ping-Pong application is provided as example.

The chapter 1: “LoRaWAN stack API” descript how to use LoORaWAN stack API.
The chapter 2: “LoRaWAN Example” descript how to use this example.
The chapter 3: “Debugging with LoRaWAN Example “ descript how to Debug with ISSM.
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2.LoRaWAN stack API

2.1. Preface

2.1.1. Architecture

The concept of the API follows the concept of primitives of the IEEE Standard for local and metropolitan
area networks — part 15.4: Low-Rate Wireless Personal Area Networks (IEEE802.15.4-2011).

The upcoming figure shows the concept of primitives of the LoRaMAC layer. The concept follows the
Request-Confirm and Indication-Response architecture. The LoRaMAC layer offers MCPS (MAC Common
Part Sublayer) services, MLME (MAC layer management entity) services and a MIB (MAC information base).

In general, the LoORaMAC layer utilizes MCPS services for data transmissions and data receptions, and
MLME services to manage the LoRaWAN network. The MIB is responsible to store important runtime
information and holds the configuration of the LoRaMAC layer.

An upper layer (e.g. the main application) is able to perform Requests which the LoRaMAC layer confirms

with a Confirm primitive. The LoRaMAC layer notifies an upper layer with the Indication primitive in case of
events. The upper layer may responses to an Indication with the Response primitive.

SR

Request Confirm Response Indication

111 1 11
S ——

2.1.2. Features

The following features are supported according to the LoRaWAN 1.0.2 specification:
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LoRaWAN device classes :
Class A/C
Class B (TBD.)

ISM Band support :
EU868 / US915 / CN779 / EU433 / AU915
CN470 / AS923 / KR920 / IN865

Compliance Test Status:

EU868  Pass
US915  Pass
CN779 In Progress -
EU433 InProgress -
AU915 InProgress -
CN470 In Progress -
AS923  InProgress -
KR920 In Progress -
IN865 In Progress
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2.2. Quick-Start API

2.2.1. Overview

This section provides a short introduction into important operations of the LoRaMAC layer. Full examples

for the different device classes are available in the example section.
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2.2.2. Initialization

The initialization function of the LoRaMAC layer is LoRaMaclnitialization( LoRaMacPrimitives_t
*primitives, LoRaMacCallback_t *callbacks ). The function has two parameters, LoRaMacPrimitives_t and
LoRaMacCallback_t. The parameters define function which have to be defined by upper layers. The first
parameter contains function pointers to the Confirm and Indication primitives, and the second parameter
contains a function pointer to the function which measures the battery level. This function is available in
the board support package.

The following code snippet provides an example for the initialization:

static void McpsConfirm( McpsConfirm_t *McpsConfirm )
{
// Implementation of the MCPS-Confirm primitive
}
static void McpslIndication( Mcpsindication_t *Mcpsindication )
{

// Implementation of the MCPS-Indication primitive

}

static void MImeConfirm( MImeConfirm_t *MImeConfirm )

{

// Implementation of the MLME-Confirm primitive

}

LoRaMacPrimitives_t LoRaMacPrimitives;

LoRaMacCallback_t LoRaMacCallbacks;

LoRaMacStatus_t Status;

int main( void )

{
LoRaMacPrimitives.MacMcpsConfirm = McpsConfirm;
LoRaMacPrimitives.MacMcpsIndication = Mcpsindication;
LoRaMacPrimitives.MacMImeConfirm = MImeConfirm;
Status = LoRaMaclnitialization( & LoRaMacPrimitives, & LoRaMacCallbacks );
if( Status == LORAMAC_STATUS_OK)
{

// Initialization successful
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2.2.3. Over-the-air actvation

The LoRaMAC layer provides a MLME-Request to perform the over-the-air activation

(LoRaMacMImeRequest( MimeReq_t *mimeRequest )). The LoORaMAC layer creates the join-request

message and reports the status of the operation with the MacMImeConfirm primitive.

The following code snippet provides an example:

static uint8_t DevEui[] = { 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00 };
static uint8_t AppEui[] = { 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00 };
static uint8_t AppKey[] = { 0x11, 0x22, 0x33, 0x44, 0x55, 0x66, 0x77, 0x88, 0x99, OxAA,
0xBB, 0xCC, 0xDD, OxEE, OxFF, 0x00 };
static void MImeConfirm( MImeConfirm_t *MImeConfirm )
{
if( MImeConfirm->Status == LORAMAC_EVENT _INFO_STATUS_OK)
{
switch( MImeConfirm->MImeRequest )
{
case MLME_JOIN:
{
// Status is OK, node has joined the network
break;
}
case MLME_LINK_CHECK:
{
// Check DemodMargin
// Check NbGateways
break;
}
default:
break;
}
}
}
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int main( void )

{
MlimeReqg_t mimeReq;
LoRaMacStatus_t status;
// This comment is a placeholder for the initialization of the LoRaMAC layer
// Setup the request type
mimeReq.Type = MLME_JOIN;
// Fill the join parameters
mimeReq.Req.Join.DevEui = DevEui;
mimeReq.Req.Join.AppEui = AppEui;
mimeReq.Req.Join.AppKey = AppKey;
status = LoRaMacMImeRequest( &mImeReq );
if( status == LORAMAC_STATUS_OK)
{

// Join request was send successfully
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2.2.4. Activation by personalization

The activation by personalization procedure requires to store important information on the LoRaMAC

node:

Network Identifier
Device Address
Network session key
Application session key

The application must configure those parameters to perform a personalized activation. In addition, the

application has to enable the LoRaWAN network itself.

The following code snippet provides an example:

static uint8 t NwkSKey[] = { 0x2B, O0x7E,
OxF7, 0x15, 0x88, 0x09, OxCF, 0x4F, 0x3C };
static uint8 t AppSKey[] = { 0x2B, O0x7E,
OxF7, 0x15, 0x88, 0x09, O0xCF, O0x4F, 0x3C };
int main( void )

{
MibRequestConfirm t mibReq;
LoRaMacStatus t status;

uint32 t DevAddr;

// Choose a random device address

DevAddr = randr( 0, OxOlFFFFFF );

mibReqg.Type = MIB NET ID;
mibReqg.Param.NetID = 0x000000;
if ( LoRaMacMibSetRequestConfirm( &mibReq )
return;
mibReqg.Type = MIB DEV_ ADDR;
mibReqg.Param.DevAddr = DevAddr;
if ( LoRaMacMibSetRequestConfirm( &mibReq )
return;
mibReqg.Type = MIB NWK SKEY;
mibReqg.Param.NwkSKey = NwkSKey;
if ( LoRaMacMibSetRequestConfirm( &mibReq )

return;

0x15,

0x15,

// This comment is a placeholder for the initialization of the LoRaMAC layer

Ox1l6, 0x28, OxAE, 0xD2, OxA6, OxAB,

Ox1l6, 0x28, OxAE, 0xD2, OxA6, OxAB,

LORAMAC STATUS OK )

LORAMAC STATUS OK )

LORAMAC STATUS OK )

MtM Technology
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mibReq.Type = MIB_APP_SKEY;

mibReqg.Param.AppSKey = AppSKey;

if( LoRaMacMibSetRequestConfirm( &mibReq ) != LORAMAC_STATUS OK)
return;

mibReq.Type = MIB_NETWORK_JOINED;

mibReg.Param.IsNetworkJoined = true;

if( LoRaMacMibSetRequestConfirm( &mibReq ) != LORAMAC_STATUS_OK)
return;

// LoRaWAN node has joined the network
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2.2.5. LoRa Mac Information Base (MIB) list

The following table lists the MIB parameters and the related attributes:

Attribute Description Get | Set
MIB_DEVICE_CLASS LoRaWAN device class Yes Yes
MIB_NETWORK_JOINED LoRaWAN Network joined attribute Yes | Yes
MIB_ADR Adaptive data rate Yes | Yes
MIB_NET_ID Network identifier Yes | Yes
MIB_DEV_ADDR End-device address Yes | Yes
MIB_NWK_SKEY Nework session key Yes | Yes
MIB_APP_SKEY Application session key Yes | Yes
MIB_PUBLICE_NETWORK The network type to public or not Yes | Yes
MIB_REPEATER_SUPPORT Support the operation with repeaters Yes | Yes
MIB_CHANNELS Communication channels Yes No
MIB_RX2_CHANNEL Receive window 2 channel Yes | Yes
MIB_RX2_DEFAULT_CHANNEL Receive window 2 default channel Yes | Yes
MIB_CHANNELS_MASK LoRaWAN channels mask Yes | Yes
MIB_CHANNELS_DEFAULT_MASK LoRaWAN default channels mask Yes | Yes
MIB_CHANNELS_NB_REP Number of repetitions on a channel Yes | Yes
MIB_MAX_RX_WINDOW_DURATION Maximum receive window durationin ms | Yes | Yes
MIB_RECEIVE_DELAY_1 Receive delay 1 in ms Yes | Yes
MIB_RECEIVE_DELAY_2 Receive delay 2 in ms Yes | Yes
MIB_JOIN_ACCEPT_DELAY_1 Join accept delay 1 in ms Yes | Yes
MIB_JOIN_ACCEPT_DELAY_2 Join accept delay 2 in ms Yes | Yes
MIB_CHANNELS_DATARATE Default data rate of a channel Yes | Yes
MIB_CHANNELS_DEFAULT_DATARATE Data rate of a channel Yes | Yes
MIB_CHANNELS_TX_POWER Transmission power of a channel Yes | Yes
MIB_CHANNELS DEFAULT _TX_POWER | Default transmission power of a channel | Yes | Yes
MIB_UPLINK_COUNTER LoRaWAN Up-link counter Yes Yes
MIB_DOWNLINK_COUNTER LoRaWAN Down-link counter Yes | Yes
MIB_MULTICAST_CHANNEL Multicast channels Yes No

Please reference LoRaMac.h of SDK to get more detail information.
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3.LoRaWAN Example

3.1. Example Introduction

This example continuous sends sensor data to LoORaWAN Gateway. It could be use OTAA or ABP method

connect to LoRa Network, then send received sensor data.

2 T

arD

Node sensors
LoRaWAN
Gateway

Figure 1

3.2. Prerequisites

Host machine:
PC running Microsoft Windows 7 or later with an available USB port.
Hardware :
(1). A LoRa Development Kit (LoRa DK).
(2). Some sensor devices. (optional)
(3). An LoRa Gateway. ( We use Band868/915 Multitech conduit for testing)

Software :
(1). Intel IDE : Intel System Studio for Microcontrollers. (Version :ISSM_2016.2.090)
(2). LoRaWAN stack SDK. (include Radio Driver) } LoRaSDK.rar
(3). LoRaWAN example source code.
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3.3. Setup Example Steps

3.3.1. Step 1: Connect the LoRa DK to host PC.

Intel Quark C1000 support JATG interface for programming and debugging. The JTAG interface of LoRa DK is
on the top left and right (block pin headers), list as below figure. Connect JTAG interface to those pins.

Board No.
::‘riNe: Functions Intel LoRa
1 AVDD vce_lo RF
2 DEC2 o
] N
2 GND GND o § LoRa DK
=
4 GND GND o ( Rev,l B2 agaz Jb
I CEREE >3 4 —|AP_JTAG _TRST_N
5 VDD VsYS 2 U L HD — — —
e | swoio
7 | swocik : P gmg 3B @ O AP_JTAG_TMS
o = ut 2 A6l

WL — AP_RESET_N “eeeeseseeees ns @O\ AP_JTAG_TDO
9 P0_27 O rss00)

T GND 000000000000 O
10 _. - 2 » [000000000000|p2H o4
1 PO_18 AP_UART[0]_RXD_ADC[18] g ; g gg g ggg gg g gg ﬁ % N AP_JTAG_TDI
2 | P | AR UARTOLTO.ShoRT VSYS 550000000000 LU =2 L=/ AP_JTAG_TCK
13 PO_14 AP_I2C[0]_SS_SDA 1 000000000000 Uce“; 24 - -
o [ aewcorsser O, BApEsEee SR X
15 PO_09 AP_GPIO_SS[2]_ADC[10] g JJo 00000000000 Er - 2
18 | Po_os AP_GPIO_AON[0] O E E . Eﬂ ka O
17 | Po_o7 AP_GPIO[0]_ADC[0] ,g ﬂ 3@ 2
18 | Fo_oe AP_GPIO[24]_SPI[0_M_CS[0] O eHe §538f, ™D O
19 PO_05 AP_GPIO[23]_SPI[0]_M_MOSI O o w O
20 | Po_os AP_GPIO[22]_SPI[0]_M_MISO 52
21 | Po_oz AP_I2C[1]_SS_SDA O g5 O
22 | Po_o2 AP_I2C[1]_SS_SCL O O
23 | Po_o1 AP_GPIO[21]_SPI[0]_M_SCK
24 | Po_oo AP_GPIO_SS[3]_ADC[11] O O
25 | Po_22 AP_GPIO_SS[10]_PWM[0]
26 | Po_23 AP_GPIO_SS[11]_PWM[1] ? 9 O O O O O O O O 16 9
27 | Po_24 AP_GPIO_SS[12]_PWM[2] m
ERET A e »00000 0Ty
29 | P0_28 |AP_GPIO_SS[0]_ADC[8]_UART[1] CTS 3 0
20 | Po_29 [AP _GPIO_SS[1] ADC[S] UART[1) RTS Q O O Q O O Q O
31| P0_30 |AP_GPIO_SS[8L ADC[16] UARTITLTXY
= | 701 i crio sseLacarmuaRTiieg | Debug port
a3 | Po_21 AP_SPI[0]_SS_MISO
24 | Po_20 AP_SPI[0]_SS_MOSI
as | Po_19 AP_SPI[0]_SS_SCK
2 | Po_18 AP_SPI[0]_SS_CS[0]
a7 | Po_17 AP_GPIO[1]_ADC[1]
ag | Po_12 AP_GPIO_SS[4]_ADC[12]
as | Po_11 AP_GPIO_AON[1]
40 | Po_10 AP_GPIO_AON[2]

Figure 2: DK Pin Arrangement
*Inter Quark C1000 use UART(1) as debug port. When user use “QM_PRINT” function, the output will at
UART(1).
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3.3.2. Step 2: Check the JTAG interface setting correct.

Please reference : “LoRa DK JTAG setup guide”.

3.3.3. Step 3: Run Intel System Studio for Microcontrollers.

Using File Explorer, navigate to the C:\IntelSWTools\ISSM_2016.2.090 directory and doubleclick
the file named iss_mcu_ide_eclipse-launcher.bat or doubleclick the shortcut at the top-disk..

EE

Intel System
Studio 2016

for
Microcontrol
lers

3.3.4. Step 4: Update target ROM

Note: Updating the boot ROM only needs to be performed once. Check with your lab
instructor to determine if this step has already been done for your board

From the Project menu select the [Update Microcontroller ROM...] menu item.

The Update Microcontroller ROM dialog box will appear. Make sure the Board is the Intel®
Quark™ SE C1000 Developer Board, and the Project type is QMSI 1.4.0. Click the Update button
to re-flash the microcontroller’s ROM.

./ Debug - Intel System Studio for Microcontrollers
File Edit Navigate Search Project Run Window Help

% Intel System Studio for | Open Project
. Close Project
*#  Getting Started ' s
for D2000 and C1000 Developer  BUild Al Ctrl+B
Build Project
- | 1 .Update ROM image or Build Working Set >
You should only need to Clean...

1. From the toolbar men
v

Build Automatically
2. In the new dialog, sel¢

. Board: selectyc. * Update Microcontroller ROM...

- Project Type: Ql Properties
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3.3.5. Step 5: Create a new project

From the toolbar select File > New > Intel Project for Microcontrollers:

' Debug - Intel System Studio for Microcontrollers
File Edit Navigate Search Project Run Window Help

New Alt+Shift+N > ¥ Intel Project for Microcontrollers
Open File... 09 Project..
9 Other... Ctrl+N
Close Ctrl+W
Close All Ctrl+Shift+W
Save Ctrl+S
Save As...
Save All Ctrl+Shift+S
Revert

Select the [Intel® Quark™ SE C1000 Developer Board] in the Select a developer board dialog.

Then, select the [Intel® QMSI (1.4.0)] project type.

Select [Intel® Quark™] as your platform configuration:

In the Setup project dialog, name the project [project name you want] and make sure the \Driver\Serial
Peripheral Interface example is selected (this sample project will be the basis for your project).

88 Create a new Project O X

Project for Microcontrollers

Select a developer board

Intel® Quark™ D2000 Developer Board
Intel® Quark™ SE C1000 Developer Board
Arduino 101 / Genuino 101 Board

Arrow Panther Board

tinyTILE Board

< Back Finish | Cancel
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Create a new Project

Project for Microcontrollers

Select a Firmware

Intel® QMSI [1.4.0] Description
Intel® QMSI [1.3.1]

Zephyr Project [1.7.0]
Zephyr Project [1.6.0]

Zephyr Project [1.4.2]

Software Interface

products.

Intel® Quark™ Microcontroller

Intel® Quark™ Microcontroller
Software Interface (QMSI) is a
Hardware Abstraction Layer (HAL)
for Intel® Quark™ Microcontroller

<Back [ Next> Einish

Cancel

' Create a new Project

Intel Project for Microcontrollers

Select a platform configuration

Core

’Intel® Quark™

Toolchain
Intel® System Studio for Microcontrollers - GCC |IA Compiler

Connection type
USB-Onboard

<Back | Next> |  Finish

Cancel

19
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' Create a new Project O X

Intel Project for Microcontrollers

Setup project

Name
YourProjeciName
Examples Description
Search Example \ This application demonstrates the use of the
& Real Time Clock (RTC) ~ Serial Peripheral Interface (SPI) loopback

= : - mode for setting up and executing of polled,
ol Perl.p.herél MERECC IRQ and DMA based transfers on SPI Master 0.
& SoC Identification

& System Clock Divisor
= Timers
E UART
& Version
 Watchdog Timer (WDT)
» = Grove Shield Examples
> = Power
[ Hello World v
< >

<57a2k7 Next > Finish H Cancel

Click the Finish button to create the new project (in your workspace).

After unzip LoRaSDK file, it include two folders first one is SDK file, another one is example file (main.c &
app.mk). Use Windows File Explorer to locate the example main.c file on your development system and
replace the contents of the main.c file in your project with the example main.c file.

You can “drag and drop” the example main.c file onto the old main.c file, from your Windows File
Explorer window to the Project Explorer window (in the Intel System Studio for

Microcontrollers window):

20 © MtM+ Bchnology Corporation. All rights reserved.
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¢ C/C++ - LoRaWANExample/app.mk - Intel System Studio for Microcontrollers
File Edit Source Refactor Navigate Search Project Run Window Help

Ny LB vRhvia W@vaEvEvEGvhkvOvQ@v®ov vilvehv o
5 Project Explorer E® ¥ =0 | amainc [sapp.mk =
» & [Quark] GPIO_Interrupt %%include $ (BASE:DIR) /drivers/libgmsi.mk
» & [Sensor] Inter_Integrated_Circuit__12C_ 100 include $ (BASE_DIR) /soc/$ (SOC_ROOT_DIR) /$ (SOC_MAKEFILE) .mk
» & [Quark] LED_Blink 101 include $(BASE_DIR)/soc/$ (SOC_ROOT_DIR)/drivers/drivers.mk
> & [Quark] LMT_Mailbox_Send_Receive lf; j :.fxc}ude s (BI}SE—DIR) /board{drnfers.mk
, ¢ [Quark] LoRaMac 103 #LDLIBS += $(APP_DIR) /ASELoRaSDK/*.o0
Croee ) 104 LDLIBS += $ (APP_DIR)/ASELoRaSDK/aes.o
> # [Quark] LoRaMacPulling 105LDLIBS += $ (APP_DIR) /ASELoRaSDK/cmac.o
» & [Quark] LoRaRX_continuous 106 LDLIBS += $(APP DIR)/ASELoRaSDK/LoRaMac.o
’ '3 [Quark! LoRaTX_ping | s | LoRaWANExample — O X
« & [Quark] LoRaWANExample [selected] 1
> ¢ Binaries =/ #m ®iR ?E
> & Includes H , —
» & LoRaSDK &« v « Work » LoRaWA... v U #= LloRaWANExample o
> ®bsp Az h CRGL:
’ @de?UQ s REER ke
> [& main. =87 - | app.mk 2017/2/}
& app.mk —E - | main.c 2017/2/
= LoRaWANExample (flashing).launch s F& »
2 LoRaVYANExample.launch @ ST »
L& Makefile
» & [Sensor] Mailbox_Send_Receive = EA ~ )
» & [Quark] PingPong & Google El#i#
» & [Quark] Power_Core
» & [Quark] RaylinTest 0220 . S 7 ’
» & [Quark] Real_Time_Clock_RTC_ 2fERE  EEm1ERE 40.2KB ===
L € ni] Camemr Clmmnk TV STPTODIEIMS =X & Ta5R5 = CONSolE I PTODEITTE E=TTSeric

Make sure you select Copy files when you perform the “drag and drop” operation between
windows.

' File Operation X

Create link locations relative to: [PROJECT_LOC v

Configure Drag and Drop Settings...

@ Cancel

Save the file by pressing Ctrl-S key combination.

3.3.6. Step 6: Setup LoRaWAN SDK

New a [LoRaSDK] folder in your project. Tap the right click in your project, select [New], select [Folder].
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s M N1 e U s -

> & [Sensor] Inter_Integrated_Circui New > 9 Project...
> £ [Quark] LED_Blink - . .
- Intel Project for Microcontrollers...
» & [Quark] LMT_Mailbox_Send_Rec 2 Mt© s .
> 5 [Quark] LoRaMac . Open in New Window % File from Template fo
v & [Quark] LoRaMacPulling Copy ctri+C FEBESIGer
; *‘f Binaries Paste Ctrl+V | & Class ‘_’-h
» @ Includes ® Delete Delete & Header File L5
> & bsp . . ce
debu Source > [¢& Source File is
e . 9 Move... &% Source Folder st
> g main.c

' app.mk Rename... F2 i Other.. Ctrl+N  jor

: . . LOTS Tdy DPE UsSed L0 SIdorse O PIro ot

= LoRaMacPulling (flashing).lat i Import... ¢ without specific prior written permi
& LoRaMacPulling.launch &y Export...
[ Makefile Build Project ARE IS PROVIDED BY THE COPYRIGHT HOLDE
> & [Quark] LoRaRX_continuous . PRESS OR IMPLIED WARRANTIES, INCLUDING
» & [Quark] LoRaTX_ping Clean Project "RANTIES OF MERCHANTABILITY AND FITNES
= [Quark] LoRaWANExample [sel] Refresh F5 [MED. IN NO EVENT SHALL THE INTEL CORP
= Tnclades Close Project ANY DIRECT, INDIRECT, INCIDENTAL, SPE
. [AL DAMAGES (INCLUDING, BUT NOT LIMITE

& ASELORaSDK C o e 2t e GOODS OR SEé\VICES' LO,SS OF USE, DATA
> BbSF{ Build Configurations > DN) HOWEVER CAUSED AND ON ANY THEORY O
» g main.c Make Targets 5 BTRICT LIABILITY, OR TORT (INCLUDING N

[& app.mk 9

& LoRaWANExample (flashing). ~ Index L .

LoRaWANExample.launch A A , prsole Bl Properties

© Make_fl‘le‘ L Debug As > ~ S

Input new folder name: LoRaSDK.

' New Folder O X

Folder l(j

Create a new folder resource.

Enter or select the parent folder:
|LoRaWANExample

th e

» & [Quark] LoRaWANExample [selected] ~
> & [Sensor] Mailbox_Send_Receive

» & [Quark] PingPong

> 5 [Quark] Power_Core

> & [Quark] RayLinTest

» & [Quark] Real_Time_Clock__RTC_

» & [Sensor] Sensor_SimplyTX

» & [Sensor] Sensor_spiTesting

» & [Sensor] SensorHello World e

Folder name: [ LoRaSDK

Advanced >>

@ Einish Cancel

Use Windows File Explorer to locate the LoRaSDK files on your development system and copy LoRaSDK files
into LoRaSDK folder.
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workspace - C/C++ - LoRaWANExample/LoRaSDK/LoRaMac.h - Intel® System Studio for Microcontrollers
File Edit Source Refactor Navigate Search Project Run Window Help

vl ®Sv&vaiNigvaevdv@vity a . S ——
| ¥ @ = |SDKv02
&5 Project Explorer 2 B% v= 08 N N ‘
» & [Quark] Core_Mailbox ~ Il 5P RB BR

» @ [Quark] FW13_mq_Hello_World « v 4 > ASELoRaWSDK > LoRaSDK_all > SDK.v02
> & [Sensor] FW13_sub_hello_world N
> € [Quark] FW14_mq_Hello_World 2 ZiE [Ed=k] pH
> € [Quark] General_Purpose_Input_Output_ GPIO_ S REEFE . R
» @ [Sensor] Inter_Integrated_Circuit_[2C_ - = Comtistoing 2017/5/12 T 0240 H1
> & [Quark] Interrupt_Request__IRQ__Lock__ Unlocl . =a| LoRaMac 2017/5/10 T4 0520 H1
» & [Quark] LoRaWAN_Development_V02 LoRaMac-definitions 2017/5/10 F4F 01:53  H 1
v E‘BéQ:fcr:i]Vt‘:RaWANExamp'e [selected] & X o LoRaMacTest 2017/5/10 FF 0153 H1
>
+ i Includes =8k * ] LoRaSDKa 2017/5/12 T 0258 A4
+ = LoRaSDK: ¢ Google Eft # radio 2017/5/11 T4 0249 H1
» B Comissioning.h board Region 2017/5/10 T4 01:53 H1
> BloRaMach Docs x| $x1276-board 2017/5/10 FF 01:53  H1
> W LoRaMac-definitions.h = .
> [ LoRaMacTesth LoRaDK_Power sx1276Regs-Fsk 2017/5/10 R 01:53  H1
> [ radio.h Work sx1276Regs-LoRa 2017/5/10 T4 01:53 H1
> [ Region.h 7 | utilities 2017/5/10 T4 0153 H
> B sx1276-board.h @ OneDrive
> [ sx1276Regs-Fsk.h
> [ sx1276Regs-LoRa.h L P 4
> [ utilities.h
TE
» & LoRaSDK.a ¢
s i
O .
w File Operation X

Select how files should be imported into the project:

O Link to files

Create link locations relative to: |PROJECT_LOC v

Configure Drag and Drop Settings...

@ ok ]| Cancel

Replace the app.mk file with LoRaSDK provided app.mk file.
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O

w C/C++ - Intel System Studio for Microcontrollers
File Edit Source Refactor Navigate Search Project Run Window Help
v .H.,‘IQ\DVQV@ NG Y EYE Yy YO YRl v® JvEilvilvtoow v

-

&5 Project Explorer B% v=10 [
> 5 [Quark] Hello_World

= it 5 1
Sensor] Inter_Integrated_Circuit_12C_ = A #E iR
> Quark] LED_BIlink <« v A « LoRaWANExample »
> Quark] LoRaBike_RX ~
s Quark] LoRaBike_TX " 2

- app.mk
main

Quark] LoRaMacPulling

Quark] LoRaRX_continuous

Quark] LoRaTX_ping

Quark] LoRaWAN_Developping

» & [Quark] LoRaWan_V02_developping
v & [Quark] LoRaWANExample [selected]

R

e[
[
& [
> [
= [Quark] LoRaMac v S REER
= [
= [
= [
= [

s ¥ Binaries 'S Google uﬂﬁﬁl*
> B Archives 1221
> @1 Includes 2017
> = bsp
> & debug Docs
> & LoRaSDK Logs
> g main.c
[ app.mk > @ OneDrive
= LoRaWANExample (flashing).launch
2 LoRaWANExample.launch v &R
[6 Makefile > 8 FE

> 5 [Sensor] Mailbox_Send_Receive

app.mk of LoRaSDK file add below settings.
LoRaSDK Setting :
"LDLIBS += S(APP_DIR)/LoRaSDK/LoRaSDKa"

3.3.7. Step 7: Build the project

Click on the Build button (“hammer” icon) on the toolbar to build the project. Alternatively,
you can select the build configuration using the drop down menu next to the Build button.
Intel® Systems Studio for Microcontrollers provides two build configurations: debug and
release. The debug configuration includes debug symbols in the compiled files to facilitate
source-code debugging. Debug is the default build configuration. The release configuration
optimizes the compiled code for deployment.
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File Edit Source Refactor Navigate Search Project Run Window Help

- Dvq vy WGBTS v v YTRBvTO TR v Syl liviveow -

& Project Explor i 1 Debug 3R 9 Wradioh (Gaesc @mainc (@mainc & LoRaMac-definitionsh |
» 9 [Quark] LoF 2 Release ~ 18989 This 1s the lefault stdi ption for Quark SE.
» & k] LoRaRX_continuous ifeq (5(SOC), quark_se)

, & [Quark] LoRaTX_ping CFLAGS += -DSTDOUT_UART 1 -DUART1_FTDI
v & [Quark] LoRaWANExample [selected N EELE
¢ Binaries C##¥ Make includes
» B Archives include $§(BASE_DIR)/base.mk
# Includes include §(BASE_DIR)/sys/sys.mk
v @ ASELoRaSDK ‘include $(BASE_DIR) /drivers/libgmsi.mk
n aesh 100include $(BASE_DIR)/s0c/$§ (SOC_ROOT_DIR) /$ (SOC_MAKE]
& ecmac.h include $(BASE_DIR)/soc/$ (SOC_ROOT_DIR) /drivers/dr:

include $(BASE_DIR)/board/drivers.mk

& Comissioning.h
LDLIBS += $(APP_DIR)/LoRaSDK/LoRaSDK.a

& LoRaMac.h

3.3.8. Step 8: Flash and run the project

Click on the drop down menu next to the Run button (“play” icon). Select [your project name]
(flashing) from the menu (“flashing” means you are going to program your built application
onto the target board’s Flash ROM). Intel® Systems Studio for Microcontrollers will recompile
the code and “flash” it to the microcontroller.

Intel® System Studio for Microcontrollers provides two options for running your app:

Intel ISSM Window Help

v iy w OQv@v ™ v

¥ 1button_led

¥ 2button_led (flashing)

¥ 3 XourProject Name(flashing)
) 2016, ¥ 4 accel_pwm

) Run As v
r and B _ :

Run Configurations...
mmon . h> Organize Favorites..

NOTE: The microcontroller “flashing” process can take time. You'll find a
progress bar at the bottom right corner of Intel® Systems Studio for
Microcontrollers:

‘Launching button_led (flashing): (93%) [ RS
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3.4. LoRaWAN Example Settings

There are several settings about how to use this example:
(1) Include SDK files.
(2
(3
(4
(5
(6
(7

Timer settings.

Define Radio =» Radio Driver : Radio.h

Region and custom channel setting

Define LoORaWAN Network parameters. =» Comissioning.h
Define LoRaMac connection parameters. =» LoRaMac.h
Used GPIO pins setting.

~—_— — ~— ~— ~—  ~—

3.4.1. Include SDK files and define parameters

® After copy example main.c file, please make sure that include file path are correct.

The default path is “LoRaSDK/xxs.h”

® |f used our “Sensor Data Example” on sub-system, we set the MailBox channel to Channel 0.
(QM_MBOX_CH_0)

Define the MailBox call back function in main.c named “mbox_cb”.

® In this example, the LoRa DataRate : DR_O, disable confirmed message(unconfirmed), and LoRaWan
application port is “1”.

3.4.2. Timer settings

Intel Quark C1000 support 4 HW timers. LoRaSDK used 1 timer(timer0). In this example, it used another 1
timer(timer1) for send Tx data event. So, there are still have 2 HW timers could be use (timer 2 and timer
3).

We are setting the timer functions in our example “main.c” file. Those are (1) Timerlnit(), (2)TimeOStop(),
(3) TimelStop(), and (4)timer_callback(). The Timerinit() function initialize the timer0 clock which SDK used,
and define the callback function to timer_callback(). The timerl used in main.c is a Tx duty cycle timer. It
could be change duty cycle time by setting TxDutyCycleTime parameter.

If want stop TimerO, please reference TimerOStop() function in “main.c”. Set the sw_timer_running to false,
then stop TimerO.

3.4.3. Define Radio ® Radio Driver : Radio.h

After include Radio.h file, user could use Radio functions to control LoRa transceiver directly.
Ex:
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® Set Radio to sleep/standby mode : Radio.Sleep();/Radio.Standby();
® Read Radio Register (address: 0x42) : uint8_t value = Radio.Read(0x42);
® Write Radio Register(address:0x12 , value:0xff) : Radio.Write(0x12,0xff);

3.4.4. Region and Custom channel Setting

LoRaSDK V02 supported LoRa SPEC V1.0.2. This version supported many Regions those are:

(1) AS923
(2) AU915
(3) CN470
(4) CN779
(5) EU433
(6) EUS6S
(7) KR920
(8) IN865
(9) US915

(10) US915-Hybrid
And two custom regions for customize channels. The custom regions are CustomAType and CustomBType.
A type is based on EU868 band parameter. B type is based on US915 band parameter.

When user want to setting custom channels, (1)select a custom type region, (2)setting your channels,
and (3) Modify band parameters in RegionCustomA(B)Type.h.

(1) Select one Region

Main.c:

#define REGION_CustomBType

(2) Setting channels:

#define LCO {902300000,0,{ ( ( DR.3<<4)|DRO)} o0}

Frequency,Rx1Freq, DataRate(Max | Min) , Band

The channels stricture is use ChannelParams_t which defined in LoRaMac.h. The first parameter is
channel’s frequency(Hz). The second is alternative frequency for RX window 1.
DataRate is setting the range. The last is band index.
User usually just need to modify first parameter and DataRate range(_). Other parameters are
copy the example.
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4o winciuaes vieg.o

49 #include "gm_gpio.h"

50

51 #include "gm_mailbox.h"

[

53=/*

54 * pefine

55 * -

56 * .

57 * - N_CN470

58 * - IOH_CNT‘ 79

59 * - ION_EU433

60 * - 68

61 * - 0

62 * -

63 * - 5

64 * - _HYBRID

65 * - REGION_ tomAType //base on EUSGE

66 * - fdefine REGION CustomBType //base on US915

£7 _*

68 //#define REGION_EZU268

5% #define REGION_CustomBType

71 #if defined(REGION_Custom3Type)

73 //ChannelParams_t frequency,Rx1Freq, DataRate (Max|Min) Band index
74

75 #define LCO { 902300000, O, { { { DR.3 << 4 ) | DRO ) }, O}
76 H#define LC1 { 902500000, 0, { ( (DR 3 << 4 ) | DRO ) }, O}
77 #define LCZ { 202700000, O, { { { DR.3 << 4 ) | DRO) }, 0}
72 §define LC32 { 902900000, 0, { ( (DR 3 << 4 ) | DRO ) }, O}
7% #define LC4 { 203100000, O, { { { DR 3 << 4 ) | DRO) }, 0}
20 H§define LCS { 903300000, 0, { ( (DR 3 << 4 ) | DRO) }, O}
21 #define LCH { 203500000, 0, { { {( DR.3 << 4 ) | DRO) }, O}
22 fdefine LC7T { 903700000, 0, { ( (DR 3 << 4 ) | DR O ) }, O}

(3) Modify band parameters in RegionCustomA(B)Type.h.
EX:

#define CustomBType_RX_WND_2_FREQ 869525000

For an Example : If want set 8 channels & Rx2 window like below.

Channel Frequency Modulation / BW
0 865.400 MHz MultiSF 125 kHz
1 865.600 MHz MultiSF 125 kHz
2 865.800 MHz MultiSF 125 kHz
3 866.000 MHz MultiSF 125 kHz
4 866.200 MHz MultiSF 125 kHz
5 866.400 MHz MultiSF 125 kHz
6 866.600 MHz MultiSF 125 kHz
7 866.800 MHz MultiSF 125 kHz
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RX2 channel (downlink)

RX2 865.200 MHz SF12 125 kHz

(1) Chose Region_CustomAType (Because, that seems base on 868band)
In Main.c add the line “#define REGION_CustomAType”

(2) Setting channels:
#define LCO {865040000,0, {
#define LC1 {865060000,0, {
#define LC2 {865080000,0, {
#define LC3 {866000000,0, {
#define LC4 {866020000,0, {
#define LC5 {866040000,0, {
#define LC6 {866060000,0, {
#define LC7 {866080000,0, {

DR_5<<4) | DR_0)}, 0}
DR_5<<4) | DR_0)}, 0}
DR_5<<4) | DR_0)}, 0}
DR_5<<4) | DR_0)}, 0}
DR_5<<4) | DR_0)}, 0}
DR_5<<4) | DR_0)}, 0}
DR_5<<4) | DR_0)}, 0}
DR_5<<4) | DR_0)}, 0}

(3) Modify band parameter

(3-1) Remove initilized channels:

Use LoRaMacChannelRemove() function to remove channel.

(3-2) Add Custom Channels:

Use LoRaMacChannelAdd() function to Add channel.

(3-3) Setting Rx2 Window Freq like below:
RegionSetCustomRX2WindowFreq(LORAMAC_REGION_CustomAType,865200000);
mibReq.Type = MIB_RX2_CHANNEL;
mibReqg.Param.Rx2Channel = (Rx2ChannelParams_t){865200000,DR_0};
LoRaMacMibSetRequestConfirm(&mibReq);
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3.4.5. Define LoORaWAN Network parameters. = Comissioning.h

LoRaWan has two method to join to LoRa Network. The first is “Over the Air Activation” (OTAA). When use
this method, user need fill out below parameters into “commissioning.h” file:

(1) OVER_THE_AIR_ACTIVATION set to “1”.

(2) DevEUI : A globally unique end-device identifier.

(3) AppEui : The application identifier.

(4) AppKey : An AES-128 key.
Each time use OTAA success join to Lora network, LoRa Gateway will response some information to end-
device. Those include (1) NetID, (2)DevAddr, (3)NwKSKey, and (4) AppSKey.

The second join network method is “Activation by Personalization” (ABP).
User fill out known parameters (after OTAA) into “commissioning.h” file, those parameters are:
(1) OVER_THE_AIR_ACTIVATION set to “0”
(2) NetlID : A network identifier.
(3) DevAddr: An end-device address.
(4)
(5) AppSKey : An application session key.

NwkSKey : A network session key.

Above network parameters could be find at the “case DEVICE_STATE_JOIN” of “switch(DeviceState)” of
“while loop” of “main.c” of “LoRaWAN Example”.

3.4.6. Define LoORaWAN parameters =»Main.c

There are two parameters often to set when use this example. That are “Datarate” and “Application port”,
both parameters could be set by follow two methods:
(a) Define the value:
#define LORAWAN_DEFAULT _DATARATE DR_O
#define LORAWAN_APP_PORT 1
(b) Set the vale when call MCPS (MAC Common Part Sublayer) services.
Ex:
mcpsReq.Type=MCP_UNCONFIRMED;
mcpsReq.Req.Unconfirmed.fBuffer = AppPort;
mcpsReq.Req.Unconfirmed.fBuffer = AppData;
mcpsReq.Req.Unconfirmed.fBufferSize = AppDataSize;
mcpsReq.Req.Unconfirmed.Datarate = DR_O;
LoRaMacMcpsRequest(&mcpsReq);
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3.4.7. Define used GPIO configuration.

LoRa DK used some GPIO pins to control RF antenna and interrupt from LoRa chip. Please note don’t re-
setting those pins and keep them workable. Those pins are GPIO Pin 4 ~ 7,20 and 28. The configuration is
defined in ” Main_lIrglnit()” function of Example. And like below in main.c :

/* Request IRQ and write GPIO port config */
cfg.direction = | BIT(4)|BIT(5) | BIT(6)|BIT(7);

cfg.int_en = BIT(SX1276.DI00); /* Interrupt enabled */
cfg.int_type = BIT(SX1276.DI00); /* Edge sensitive interrupt */
cfg.int_polarity = BIT(SX1276.DI00);  /* Rising edge */
cfg.int_debounce = BIT(SX1276.DI00); /* Debounce enabled */
cfg.int_bothedge = 0x0; /* Both edge disabled */

cfg.callback = gpio_example_callback;
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3.5. LoRaWAN Example flow chart

The example use “DeviceState” parameter to switch process flow. After the flow into Case:
“DEVICE_STATE_CYCLE”, main thread will turn on Timer1. Until interrupt occur, interrupt service will check

the “Network” state and set the “DeviceState” to the right state.

Start : Main thread

!

4 Initialization: )
(1)Start Sensor ARC
(2)Boardlnit
(3)GPIO_IRQInit
\_ (4)MailBoxInit(optional) Y,

l
s — 2 \ Timer 1 fired No

While Loop () : Process Yes

Switch(DeviceState) \ DEVICE_STATE_INIT )
v OnTxNextPacketTimerEvent()

s N

Process
DEVICE_STATE_JOIN
4 \I/ I
Process
| DEVICE_STATE_SEND ) :

\I/ DeviceState =
~ DEVICE_STATE_SEND
Process

DEVICE_STATE_CYCLE Dovicasat
. evicesState =
K _ _ TurnonTimerl D, / \ [ DEVICE_STATE_JOIN j

[ IRQ: Interrupt service ]

J

Process description:
(1) DEVICE_STATE_INIT:
Initialize LoRaMacPrimitives, LoRaMaclnitialization(Region) , special settings.
(2) DEVICE_STATE_JOIN:
if use OTAA, set necessary parameters: DevEui, AppEui, and AppKey.
If use ABP, set networkID, DevAddr, NWK_SKEY, and APP_SKEY.
(3) DEVICE_STATE_SEND:
If ready for send, prepare the TxFrame, then send the Frame.
(4) DEVICE_STATE_CYCLE:
Set the cycle time, and then turn on timel. When timer fired, check the state. If joined network send

data, else request join network.
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3.6. LoRaWAN Example Receive data
)
Respanse

Rogqurest Confirm Indication

1 1 1 1
N S—

When LoRa DK receive data from gateway, the function “Mcpsindication( )” will called. Reference

|

Mcpsindication_t (LoRaMac.h) to know the data structure. Check receive data from mcpsindication-
>[parameter].

Ex : Check Application Port, RSSI, Snr.

In McpslIndication( ) :

QM_PRINTF(* Port :%d”, mcpsIndication->Port);
QM_PRINTF(* RSSI :%d”, mcpsIndication->RSSI);
QM_PRINTF(* Snr :%d”, mcpsIndication->Snr);

Note : Mcpsindication_t Data structure :

typedef struct sMcpsIndication
{

uint8_t Multicast;

uint8_t Port;

uint8_t RxDatarate;

uint8_t *Buffer;

uint8_t BufferSize;

intl6_t Rssi;

uint8_t Snr;

bool AckReceived;

uint32_t DownLinkCounter; //The downlink counter value for the received frame

IMcpsIndication_t;
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4.Debugging with LoRaWAN Example

After your app “flashed” and is running on the board you can debug the application without flashing it
(again) to the board. Click the drop down menu next to the Debug button (“bug” icon) and select LoRa
Example (second option) from the drop-down menu:

Establish a serial connection to the board

Run Intel ISSM Window Help

#BO Qvy®y~vBiN

_ 1 LoRa Example(flashing)
- 'Q _A_Z LoRa Example |
Debug As 4

Debug Configurations...
Organize Favorites...

pl

Intel® System Studio for Microcontrollers provides two options for debugging your app:

1. The LoRa Example (flashing) option compiles and programs the application onto your target system Flash
ROM before the application is run. Use this option if your application’s source code has changed since the
last time the board was “flashed.”

2. The LoRa Example option assumes that your board has already been programed with the application.
Use this option if you do not need to update the application on the board since the last time it was

“flashed” and run.
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4.1. Establish a serial connection to the board

Please take an USB to RS232 cable, and connect TX, RX and GND pins to DK debug port and GND (Ref.
Figure 2). USB-RS232-TX connect DK pin 32(RXD); USB-RS232-RX connect DK pin 31(TXD)

TXD RXD

GND
+33V

USB s

From the toolbar in Intel® System Studio for Microcontrollers select Window > Show View >
Serial Terminal:

' C/C++ - Intel System Studio for Microcontrollers

File Edit Source Refactor Navigate Search Project Run Window Help

Oyl ®vyQ~vimw NNgvavdv@visvOy New Window v * v

& Project Explorer B v=0 m\ qutor > bec ain nain g Comissioning.h

> & [Quark] GPIO_Interrupt Hide Toolbar

> & [Quark] Hello_World 4/ Show View > =& Microcontroller Registers

» & [Sensor] Inter_Integrated_Circuit__[2C_ Re Perspective 5 Y Memory Usage.Summary (]
> & [Quark] LED_Blink > € — & OpenOCD Session

» & [Quark] LMT_Mailbox_Send_Receive Navigation > & Serial Terminal

» & [Quark] LoRaMac ¥ OS Awareness

Preferences

> i [Quark] LoRaMacPulling [selected]
> & [Quark] LoRaRX_continuous
» & [Quark] LoRaTX_ping

C/C++ Projects

Console Alt+Shift+Q, C
Include Browser

w0 &

click for new
serial connection

In this new window click on the Green plus sign to start a serial connection. Then set the COM
port to the one you observed from your host PC and leave the other fields in their default settings.
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v Debug - Timers/main.c - Intel System Studio for Microcontrollers - X

File Edit Source Refactor Navigate Search Project Run Window Help

nld |6 P OEN- - RS HvOvAvEIv[dlvilvoovoy [Quick Access || & | & C/C++ 42 Debug
#Debug = (& Project Explore #li» v=n8 Breakpoints #Registers 3 = Module tB|rie =8
v ¥ LoRaMacPulling (flashing) [MCU cfg] Name Value Description

v & LoRaMacPulling.elf 44 General Registers General Purpose and FPU Register ...

+@ Thread #1 (Running : User Request)
& C/IntelSWTools/ISSM_2016.1.067/tools/debugger/gdb-ia/bin/gdb-ia.exe (7.9)

igLoRaMac.c  [@main.c @ main.c = [ Comissioning.h B LoRaMach (& gm_uart.c == Jutline =¥ Disassembly 2 =8
52 /* QMSI timer app example */ ~ Enter location h ~ || & & &R rs e <

P 53¢int main(void) e e

|

| 3 /* Variables */

g 56 gm_pwm_config_t sw_cfg;

:I 57 uint32 t lo_cnt, hi_cnt;

| K uint32 t sw_lo_cnt = 0x4CCCA*10;//0x4CCCA = 0.01ls = 10ms

n{ 59 uwint32_t sw_hi_cnt = 0x00;

| P v

D Console = 7 Tasks P E table ABE®| @@ B v ovy =0 QSerial Terminal = lemory Usage Su 5 OpenOCD Sessio OS Awarenes -0

LoRaMacPulImg (flashing) [MCU cfg] C/\ntelSWTooIS/\SSM 2016.1.067/tools/debugger/gdb- |a/b|n/g( COMB® [disconnected] )

and "show warranty" for details.

This GDB was configured as "x86_64-w64-mingw32".

Type "show configuration" for configuration details.

For information about how to find Technical Support, Product Updates,
User Forums, FAQs, tips and tricks, and other support information, ple
<http://www.intel.com/software/products/support/>.For help, type "helj
Type "apropos word" to search for commands related to "word".

The port is not connected

Writable Smart Insert | 59:9 -
T 04:12

2017731

4.2. Setting and removing breakpoints

The simplest way to set or remove a breakpoint is by using the “Toggle Breakpoint” function.
One way to do this is by right-clicking the blue vertical bar immediately to the left of the code
line on which you want to set (or remove) a breakpoint; and selecting the Toggle Breakpoint
menu item that appears in the right-click context menu.

4.3. Controlling code execution

You control code execution during a debug session by using the toolbar buttons shown in the
screenshot below; by using their corresponding shortcut keystrokes (for example F5 > Step
Into, F6 > Step Over, F8 > Resume, etc.); or by using the commands on the Run menu to
control the code execution.

Follow the next steps to practice debugging your app:

= P R A i

>

esum

M
cC

i Click the Resume toolbar icon once; your app will run to the breakpoint set in the
previous step.
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i Press the Resume icon again to continue running your app.
i Push Suspend to pause the app.

These commands are also accessible using the right-click menu inside the Debug window.

4.4. Adding a conditional breakpoint

Conditional breakpoints are useful for suspending code execution when a specific condition is
met. Right-click on the vertical blue bar to the left of the code line where you want to add a
conditional breakpoint and select the Add Breakpoint... menu item. The Properties for C/C++
Line Breakpoint dialog will appear. Enter the condition expression in the Condition text box.

4.5. The Microcontroller Registers view

The Microcontroller Registers view allows you to view and modify Intel® Quark™
Microcontroller peripheral registers while the app is running in Debug mode. This feature is
useful when debugging on-chip peripherals and their interaction with external hardware.

' C/C++ - Intel System Studio for Microcontrollers — X
File Edit Source Refactor Navigate Search Project Run Window Help
(wl 4 [ ®vyQvia N@vavdvEvHvOvQAv® Pl vi v ovow Quick Access || & | B C/C++ # Debug
& Project Explorer = B% V=18 Microcontrol... 2 {dloRaMacc @mainc [@mainc ®loRaMach [@gm_uartc @mainc = O g Outline = ake Target -8
@ [Quark] LED_Blink A B8 Arch:x86 Vendor: Intel Chip: Quark_SE <
[Quark] LMT_Mailbox_Send_Receive Register Hex Bin Reset  Ac.. Address Description A Anoutline is not available.
# [Quark] LoRaMac e fst_io_i2c_mst0_reg_i fst_io_i2c_mst0_reg
~ % [Quark] LoRaMacPulling [selected] e fst_io_i2c_mst1_reg_i fst_io_i2c_mst1_reg
> # Binaries e fst_io_adc0_reg_i fst_io_adc0_reg
@ Includes e fst_io_gpio_8b0_reg_i fst_io_gpio_8b0_reg
v = bsp = fst_io_gpio_8b1_reg_i fst_io_gpio_8b1_reg
v i board e io_creg_mst0_reg_i io_creg_mst0_reg
v i drivers e fst_periph_wdt_reg_i fst_periph_wdt_reg
& bmx1xx & fst_periph_rtc_reg_i fst_periph_rtc_reg
v & radio & fst_periph_pwmt_reg_i fst_periph_pwmt_re
[ aes.c v & fst_periph_GPIO_reg_i fst_periph_GPIO_rec
(5 aes.h > [Z GPIO_SWPORTA DR 0x0000.. RW 0xB00O... Port A Data
g cmac.c > [ GPIO_SWPORTA_DDR 0x0000.. RW 0xB000... Port A Data Directit
B cmach = GPIO_SWPORTA_CTL 0x0000.. RW 0xB00O... Port A Data Source
[ Comissioning.h = GPIO_INTEN 0x0000.. RW 0xB00O... Interrupt Enable
12 LoRaMac.c = GPIO_INTMASK 0x0000... RW 0xB00O... Interrupt Mask
[ LoRaMac.h [Z GPIO_INTTYPE_LEVEL 0x0000... RW 0xB000... Interrupt Type
(8 LoRaMacCrypto.c > [ GPIO_INT_POLARITY 0x0000.. RW 0xB00O... Interrupt Polarity
® LoRaMacCrypto.h =] GPIO_INTSTATUS 0x0000.. RO 0xBOO0O... Interrupt Status
[ LoRaMac-definitions.h = GPIO_RAW_INTSTATUS 0x0000.. RO 0xB00O... Raw Interrupt Statu
[ radio.h = GPIO_DEBOUNCE 0x0000.. RW 0xB000... Debounce Enable
[ sx1276.c < >
(5 sx1276.h - -
& sx1276-board.c oblems <s @ Console 2 o S #Search & “zIn ole
[8 sx1276-board.h - |BpEE B8 vravyo~ Lo %k EESETvE
B sx1276Regs-Fskh LoRaMacPulling (flashing) [MCU cfg] C:/IntelSWTools/ISSM_2016.1.067/tools/debugger ‘loramactest’ - 47 matches in works&ce
 sx1276Regs-LoRa.n and "show warranty" for detiils. ) . ~ = 88: .textLoRaMacTestRxWindowsOn ~
5 utilities.c This EDB was col:)flgurgd is x86_647w64—m:.mgw32 .. 5 90: text.LoRaMacTestSetMic
@ Utf_ 5 Type "show cgnflguratlon for (.:onflguraFlon details. % 92: text LoRaMacTestSetDutyCycleOn
5 utilities.h For information about how to find Technical Support, Produc , & LoRaMac.c (4 match
[ drivers.mk User Forums, FAQs, tips and tricks, and other support infor @ LoRaMac.c (4 matches)
= bootloader hitre / Jumms intal cem/anfruare frratiet o/ cmnert /e Far haln (& LoRaMacTesth (9 matches)
 der v < > [& main.c (4 matches) v

T 04:22
2017/3/1

i}

4.6. Other debug views

There are multiple debug views available — feel free to explore them on your own. Here are
just a few of the more commonly used views:
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® Disassembly view

® Registers view

® Memory view
Use Windows > Show View menu to select the views. Note that the views available will vary depending on
the active perspective.

4.7. OpenOCD view

The Intel® System Studio for Microcontroller uses OpenOCD software to communicate with
the Intel® Quark™ SE Microcontroller C1000 through its JTAG interface. This software drives
the OpenOCD view. In some cases, for example when the board is disconnected and
reconnected from its USB connection, it might be necessary to restart OpenOCD. This can be
done by clicking the Stop OpenOCD (red “stop” icon) button, and then clicking the Start
OpenOCD (green “play” icon) button at the top right corner of the OpenOCD view. You must
restart the debugging session after OpenOCD had been restarted.

5.Reference:

Quark-c1000-datasheet

Intel Quark SE Microcontroller C1000 Platform Design Guide
SX1276 Datasheet

LoRaWAN Specification 1R02
LoRaWAN_Regional_Parameters_v1_0-20161012_1397_1
http://stackforce.github.io/LoRaMac-doc/
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